


WEB PAGE DESIGN WITH ADOBE DREAMWEAVER CS4
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INTRODUCTION:

Many people have experience in building web pages through template sites such as FaceBook,
Piczo or MySpace. However, many students have not had the freedom or opportunity to create
and design an original site either by coding HTML or through WYSIWYG (What You See Is What
You Get) editors. Through this module, students have the opportunity to develop basic web page
design skills by building a practice website using Adobe Dreamweaver. Dreamweaver Creative
Suite 4 (CS4), is a well-known web editor that allows you to design, build and manage websites.
This WYSIWYG web editor allows you to create your web page visually (rather than coding
HTML), and what you see on the screen while designing is what you will see when your site is
loaded in a web browser like Internet Explorer.

Besides providing students with basic technical skills, this module also helps students evaluate
the design of websites and examine the importance of web accessibility.

OUTCOMES:

In this module, students will:

learn how to create a basic website using a WYSIWYG editor
develop a plan for building a website

identify the elements of a web page

recognize the importance of website accessibility

evaluate websites for positive and negative features

o U AW N =

incorporate good design techniques when building websites



Part I: Basic Steps for Website Creation with Dreamweaver

We’re going to take a look at the Dreamweaver workspace and then create a practice website
for a pretend pizza restaurant business called “Your Name’s Pizza Palace” to help you learn the
basics of the program. Make sure you follow all instructions carefully!

NOTES:

1.

There are several ways to accomplish the same tasks in Dreamweaver. The instructions that
follow will show you one method, but as you become more familiar with the program, you
may find alternate ways to do the same things.

. Students should recognize that while you are creating your site, it is being developed locally.

This means that it is not available online until it is uploaded to a special computer called a
Web server. You can preview what your site will look like at any time after you save by
pressing F12, but you need special access to a server to upload your files.

. Management of files is extremely important when designing web pages! Make sure you create

a new folder for every different website that you create and save all related files to this
folder. If you were to upload your site to a Web hosting service, you would need to include
ALL files (HTML, images, CSS). Using good file management practices makes this process
easier.

Due to space limitations on school web servers, this module does not provide detailed
instructions for uploading files to this location. The decision to post web sites is left to the
teacher and STC. If students are interested in publishing their sites online, it is suggested
that they search for a free web hosting service or find out if their Internet Service Provider
includes space as part of their package. Students who choose to post their sites online
should take all precautions to protect themselves (ex. do not include full name, address, or
other identifying information.)

. When naming files and folders:

a) Keep your file names short but descriptive

b) Avoid using spaces (use an underscore instead ex. contact_info.html)

c) Don’t use capitals or punctuation

Don’t forget to SAVE regularly and don’t forget that if you don’t like the way something
turns out, you can UNDO so your latest changes don’t take effect.
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1. Controlling the panel elements on your screen.
Under the Windows tab, you can control which elements appear on your screen.
The shortcut keystrokes that are shown in the menu allow you to quickly turn on
and off the individual elements that you wish to appear on your screen.
2. Quickly Resetting the Default Screen Elements
To quickly reset the screen setting s, you can choose Workspace Layout from the
Windows menu, and then select Reset ‘Designer’. This option is also available
along the tool bar as shown above. The default ‘Designer’ settings will have a
split screen. You can switch this back to Design
mode only by click on the Design icon at the top of | P Fie Edit View Insert fy F

the screen.

Let’s get started.
Turn the page...

Untitled-1 X
|2l code | <5spit | (5] vesion | | uive view




Lesson 1: Defining a Site

Some websites have thousands of files associated with them, including the HTML files and
images, along with other types of support files like css files (cascading stylesheets), flash
movies, or Javascript. Managing these files is extremely important. How many times have you
gone to a website only to see an “X” where a picture should be? This means that the browser
can’t find the file that should be in that spot. Although it may seem boring, managing all of your
files is extremely important!

Dreamweaver includes a site management utility that will help you keep track of all your files.
By defining your site, Dreamweaver will track all your files and make necessary changes to your
links when you move or rename files. ALWAYS define a site before you start creating your pages
in Dreamweaver.

1. Open Dreamweaver

2. A window that looks similar to below will open. Click on Site = New Site (Note the menu
options at the top of your screen; you will be using these menus throughout the lessons.)

Eﬂ File  Edit ‘iew Insert Modify Format  Commangs W, Help | ERv v v

[Strl+EhittHD
[Efrect [t By s [ e
it (Sl hrte
[Efiect | iy P (e e ]
e et [t
Stiavy Checked Dot B,
[Lacate it Site
Open a Recent Item Reports... Top Features (videos
) ) Synehreniee Siewrde... 3 .
Bl ceisindexhinl Check Links Sitewide  Cti+FB H%H Eelateclies
T acisiuntitled Hmi Change Link Sitewide... .
F[i;] goisthrColElsHdr ces Advanced > HE M
= il . N {1 [

. e _sge q . Basic |F\dvanced|
The Site Definition window will open. -
. . Site Definition F[ i’
4. Give your site the name “Your Name’s

Pizza Palace” (Don’t worry about the URL

right now).
A site, in Dreamweaver, is a collection of files and Folders that corresponds to a website on a

5. Click Next z

What would you like ko name your site?

I Pizza Palace|

wample: mySite

Editing Files Testing Files Shating Files

‘What is the HTTP Address {URL) of your site?
| ntp:f
Example: http: v, myHost. com/mySite

If you want to work directly on the server using FTP or RDS, you should create an FTP or RDS
server conneckion. ‘Working directly on the server does not allow you to perform sitewide
operations like link checking ar site reparts,

= Bacl ‘l Mext = i ’ Cancel Help

N—




6.

(NOTE: Every website should have its own
folder. The G: drive was selected here
because that is where you must save all your

When asked if you want to Site Definition for Pizza Palace
work with server technology, @ B2 | Advanced |

make sure “No” is selected. EN = -
, Site Definition 2k S~
Click Next 4

Editing Files, Part 2 Testing Files sharing Files

Do you wank to work with a server kechnology such as ColdFusion, ASP.MET, ASP, J3P, or PHPY

ant to use a server kechnology.
" Yes, Twant bb use a server kechnology,

Make sure you have “Edit local copies on

my machine...” selected.
Basic |P.dvanced|
EN = £ ]
Site Definition =3 "

Identify where your website files will be
stored. Type G:\webpage_design\pizza as
shown in the graphic (unless told to do
otherwise by your teacher). Dreamweaver
will create the folders webpage_design
and pizza in your G: drive.

Editing Files, Part 3 Testing Files Sharing Files

ay) want ko work with your files during development?

opies on my machine, then upload ko server when ready (recommended)
= Edit direcly on server using local netwark

“Where on your computer do you want to stare your Files?

files while at school. If you were working at
home, you would choose another location).

10.

1.

12.

Click Next

Site Definition for Pizza Palace

In the next window, click on the dropdown _
arrow and select None when asked how you Basic | advanced |
connect to your remote server. =
= h—.Aana T ("'_‘-—-.___
Site Definition :

Click Next Editing Files Testing Files Sharing Files

How dao wou connect bo your remote serwver?

INu:une

Local/Metwark
WebDay

RDS
Microsoft® Yisual SourceSafe®




13. In the Site Definition Summary window, click Done.

Site Definition for Pizza Palace

Basic | Advanced |

Site Definition h“—"@

‘Your site has the Following settings:

Local info: {Local root folder will be created)
Site Mame: Pizza Palace
Local Root Folder: Gilwebpage_designipizza),

Remote info:
Access: Ill set this up later,

Testing server:
Access: Ill set this up later,

‘four site can be Further configured using the Advanced Tab.

< Back | Done I Cancel | Help

14. Your site folder should now be showing in the Files Panel at the bottom right of your screen.
(If the Files Panel is not showing, press F8)

FILES =

I[ED Pizza Palace j ILDcal g j
T W =5
g G | L {} ‘

Local Files

REMEMBER: Before you begin creating any web site in Dreamweaver, always

DEFINE A SITE just like you did in the previous steps.




Lesson 2: Adding a Homepage (Using Dreamweaver Layouts)

Now that you have your site defined, we can add the first page to your site. In this lesson, we
are going to create a two-column layout with a header and footer. This is a common layout used
by web designers. Dreamweaver has several premade layouts available to you. As you become
more familiar with the program, feel free to try out the different designs.

g

i

1. Click on File> New.

Browize in Bridge. ..
Open Recent

I peEm i Erame., .
[Hoze

Elmeedll

Insert  Modify  F

Clrl+00
Chrl+aJt+0

(Sl St
[SEr e
[kl Sty

2. The New Document window will open. This allows you to select a layout for your page.

HNew Document
Page Type: Layaut:
—— “i HTML ZNone = =
ITB SO a0 T HTML kemplate 1 column elastic, centered o
= Library item 1 columnn elastic, centered, header and
@ Blank Template = LT (Entire page) 1 colurnn fixed, centered
= ST (Fragment) 1 column fixed, centered, header and F
- ; ActionSeript 1 column liquid, centered
- Page from Template | 22 o5 1 colurmn liquid, centered, header and F i
= Javascript z co:umn e:asgc, :BIEE sEIeEar -
= — columin elastic, left sidebar, header al
Dl Page from Sample | T %ML ' !
j d P - 2 oaolumnn elaskic, right sidebar

ASP JawaScripk \

2 column elastic, right sidebar, header .

’ Other . AT BT ST
(PR c 2 colurnn fixed, left sidebar, header ar >
ASPMET C# T e msiahisidem— |
ASP.MET VB 2 column fixed, right sidebar, header a—
ColdFusion

2 column hybrid, left sidebar
CaldFusion component

EEEEIEEIEIE

2 column liquid, left sidebar

2 column liguid, right sidebar
<]

2 column heybrid, left sidebar, header ai
J5P 2 column hevbrid, right sidebar

- . < Layaut £55:
PHP 2 column heybrid, right sidebar, header .

2 colurn liquid, left sidebar, header ar |

il

Twa columns, all widths in pixels, with left
sidebar, header and footer,

DocTypes : i I ;'t'gned vI

ICreate Mew Flﬁ
e

Help | Preferences. .. | Gek more conkent. ..

F Create I Cancel

3. Blank Page should be selected and the Page Type should be HTML.

In the Layout column, select 2 column fixed, left sidebar, header and footer. When you

create your own site, experiment with different layouts to see what they look like.

5. Look for the item Layout CSS in the bottom right corner of the window. Make sure Create
New File is selected. Dreamweaver will create a separate Cascading Stylesheet file that will
control the appearance of all pages in your site. More on this later.

6. Click the Create button in the bottom right corner.



7. The Save Style Sheet File As dialog box will appear. Don’t change any settings. Click Save.

Save Style Sheet File As 2 x|
Savein: IE} pizza ENGNE

Desktop

o

My Documents Do not change the file name.
ﬁ,[ Click Save.

ty Computer
-“

by Metworl File name:
=

j Save
j Cancel |

Saveastyps: | Style Sheet Files (*.cos]

Site: Roak |

A

8. Dreamweaver will now create the 2 column page for you with “dummy” text that we will
replace later with your text. Your screen should look similar to below. Your panels on the
right side of your screen may be slightly different. All panels are found under the Window
menu if something is missing.

DW Fe Edt Vew Insert Modfy Fomat Commands Ste Window Help | B £+ &~ | Desener ~ | (B ] -9

Uniitled1 %

Commen

| Ll code | < spit [ [ G veson| | #[uveview |w| Lo code | Tide: Unttled Document 8% & B chewm‘ o " .
: Hyperlnl =
' Header .
& Hamed Anchor

Harizarial Ruie

| sidebarl Content Main Content F Tk

i Insert Div Tag

i The background color on Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

i this div will only show Praesent aliquam, justo convallis luctus rutrum, erat nulla B~ Tmages : Nevigation Bar

i for the length of the fermenturn diam, at nonumimy quarm ante ac guarm. I &1~ vedia

b content. If you'd like a Maecenas urna purus, fermentum id, molestie in, commodo . —
i dividing line instead, porttitor, felis, Nam blandit quam ut lacus. Quisque ornare | =

i place a border on the risus quis ligula. Phasellus tristique purus a augue 1) server-side ndlude

i left side of the condimentumn adipiscing. Aenean sagittis. Etiam leo pede,

i #mainContent div if it rhoncus venenatis, tristique in, vulputate at, odio. Donec (=) comment =

H will always contain et ipsum et sapien vehicula nonummy. Suspendisse

i more content. potenti. Fusce varius uma id quam, Sed neque mi, varius
H eget, tincidunt nec, suscipit id, libero. In eget purus.

i Donec eu mi sed turpis Westibulum ut nisl. Donec eu mi sed turpis feugiat feugiat
b feugiat feugiat. Integer Integer turpis arcu, pellentesque eget, cursus et,

§  turpis arcu, fermentum ut, sapien. Fusce metus mi, eleifend

{  pellentesque eget, sollicitudin, molestie id, varius et, nibh. Donec nec libero
i cursus et, fermentum

§  ut, sapien. Fusce metus H

§  mi, eleifend sollicitudin, H2 level headlng
i molestie id, varius et,

FILES
| Pizza Palace =] [tocal view ¥

Recl(tadas|m

iz e
) 5te - Pizza Palac, Folder

[ nibh. Donec nec libera Lorem ipsum dolor sit amet, consectetusr adi i i I
" : : Nrmmcmmb slicnmme dedo cmmo =l lie Lok e L |
<body kwoColFixLtHdr > <div#container» <divitheader> <hl> DR 3 4 7K [ 1 sec Unicode (T
PROPERTIES =
<5 HTML Targsted Rule [ bwoColFisLtHar #hea.., Fort [Verdana, Aria, = @
i <55 Edit Rule €55 Panel Siee [100 =] [ | X &
e [ — . -
2| @ Ready Log... |

9. If your screen shows up in Split view (both code and design are e
showing), switch to Design view by clicking the Design button
at the top left corner of your window. Try switching between
Code, Split, and Design views to see what they look like.

i M Design
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10. Before you add any content, you should save your file. Click File > Save. The Save As dialog

box will appear.

Save As

Savein: I@pizzi j (€] 7. B R

% twoColFigLtHdr cas

Replace Untitled-1.html with index.html
Er[ Do not use uppercase letters or spaces.

Make sure you are in the correct
folder before you save your file. In this
case, you should be inside “pizza”.

My Carnpuiter \
-

File mame: Iinde;?html j

Site Roaok |

Unicade Mormalization Farm: _ {Canaonical Decampasition, Followed by Can!

™ Include Unicode Signature (BOM)

Save

Save as type: IAII Documents [ htm:" html;".shtm;".shtml;“.htafﬂ Cancel |

Z

11. Find the pizza folder you created in your G: drive when you defined your site.

12. Give your file the name index.html
13. Click Save.

14. The Files Panel should now show the root folder (Your Name’s Pizza
Palace) along with the file index.htm and the css file that was created

when you defined your site. The file list in this panel acts as a file

manager. This is where you should copy, paste, delete, move, and open

files just as you would on your home computer.

15. Note that the file name (here it’s index.html) is shown on a tab at the

top of your page. Always make sure you save your file as you are
working! If you see an asterisks (*) beside the file name, this
means that changes have been made since the last save.

FILES

I[EDPizza Falace j ILocaI e j
AR A YT

Local Files

T indes hitml
L% twoColFixltH... KB Cascadin

Kl — o

File Edit view Insert M

16. Press F12 to preview your page in your default web browser.

indes html*

twoCalFixLtHdr . css

17. Save your file regularly! Do not wait until the end of class.

11
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Lesson 3: Adding Content

This page is your “homepage” which is usually the first page visitors see in your site, so we
need to change the content of the site to reflect our pizza restaurant.

1. Change the Title of the page to Your Name’s Pizza
Palace. Note that this is the name that search engines 4—""""'_—-_"""‘\3
A

will show and it also shows up in the title bar at the ¥ | Li]Live Code (Title: Pizza Palace|

very top of your browser window. Do not leave it as \..___________/

“Untitled Document”. i

NOTE: This title does not show up on your
page. It appears in the title bar at the top

of your browser. If you don't give your
page a title, it will show up as Untitled.

2. Highlight the word Header and replace it with Your Name’s Pizza Palace (Replacing text is
done just like a word processor). This is the main heading on your page. The two columns
below this header will contain your links in the left column (the Sidebar) and the main

content in the right column.

3. Fillin the Welcome! as shown in the figure below. Do not change any other items yet.

(4] Design l | F| Live Migw |vl Live Code Title: |Pizza Palace I & 'E‘v i, B 7 checkPage

Pizza Palace

______________________________________

Sidebarl Content Welcome!

The background color on Over 10 vears of delicious pizza and pasta, courteous
this div will only show ! service, and much more!

for the length of the ,

content. If you'd like @ ! H? level headina

4. The H2 level heading shows that you can have subheadings if you want (you could just
delete it if you didn’t need it). Replace this heading and the content as shown in the graphic
on the following page. Feel free to add any items you wish. To skip a line, press the Enter

key.

NOTE: Holding down the Shift Key while pressing Enter will move

to a new line without skipping a line.

12



_OIFIXLEHON. 055

o | | esign ] |FF | Live View |v| Live Code

. & 'E‘. F. B [ CheckPage

Title: | Pizza Palace

Pizza Palace

______________________________________

Sidebarl Content

The background color on
this div will only show
for the length of the
content, If yvou'd like a
dividing line instead,
place a border an the

left side of the
#mainContent div if it
will always contain

more content.

Welcomel!

Ower 10 years of delicious pizza and pasta, courteous
service, and much more!

Today's Featured Items:
12" pizza and 9" Garlic Fingers - $15,99

12 Buffalo Wings - $8.99

2 Super Donairs & 1 large caesar salad - $16.99]
Donec eu mi sed turpis
feugiat feugiat, Integer !
turpis arcu, :

5. Scroll down to the Footer at the bottom of the page. The Footer usually contains copyright
information and maybe the date the site was last updated. Replace the word Footer as
follows.

Copyright © 2009 Your name’s Pizza Palace | last updated (insert today’s date)

6. The copyright symbol “©” can be inserted by going to Insert > HTML - Special Characters
- Copyright

7. The date can be inserted by clicking Insert = Date. A dialog box will open asking you which
format to use. Check Update automatically on save so the date will change whenever you
make a change to the site.

Insert Date

j K

Day Format: |[N|:| dary]

Pl

Date Format: Zancel
O7-Mar-1974
7-mar-74 Help
0310771974
317174
1974-03-07 LI

Time Format: |[M

I¥ ELlpdate aukamatically an Save

13



8. Your site should look similar to the following. If you’re happy with the changes you’ve made,
click File - Save. We’ll change the sidebar content later.

|iDesignl |# | Live View |v] Live Cods Title: | Pizza Palace I & 'E‘. &, B [ checkPage
Sidebarl Content | Welcomel!
The background color on Over 10 years of delicious pizza and pasta, courteous
this div will only show ! service, and much more!
for the length of the :
content, If you'd like a ! T .
dividing line instead, .| Today's Featured Items:

place a border on the

left side of the 12" pizza and 9" Garlic Fingers - $15.99
#mainContent div if it .
will always contain : 12 Buffalo Wings - $8.99

more content.

2 Super Donairs & 1 large caesar salad - $16.99
Donec ey mi sed turpis
feugiat feugiat., Integer
turpis arcu, :
pellentesque eget,
cursus et, fermentum :
ut, sapien. Fusce metus :
mi, eleifend sollicitudin, :
molestie id, varius et,
nibh. Donec nec libero,

Copyright © 2009 Pizza Palace | last updated August 17, 2009

9. Press F12 to preview your page in your web browser.

14



Lesson 4: Adding Graphics

Before adding images to your web page, you should create a folder to store these pictures.

Open *ith "
Edit »
Comman Select »

% Hyperlink Get

= L [BhiEsk

=" Email Link Fut

% Narmed Anchor ekl
I hde Eheck Dt

el L Shew Checked Out By,

ol Back Eage

cEl Table
: . . — [Ei itk EEmmt
1. In the Files Panel, right click and select New _ S RS
Insert Div Tag SUREHTEHAEE..
FO Ider- = o [ replaw Spmehroniee [ Hermation
Sy ™ Images : Navigati Wersion Control »
A+ Merin Cloaking »
LS Turmn off Read Only
Pizza Palace ~  Locate in Remate Siee
gﬂ c | &4 Presizws in Browser 3
Check Links 3
. Sdd |t Favarntes
t index:, html [Wesign Wates:

} twoCcolFixlt Ewplore...
\ Refrezh Local Files
Right click|here
1| I »
@ select “New Fol

2. A new folder called “untitled” will show up under your file names. Name the folder images.
Your Files Panel should look similar to the following:

IEB Fizza Palace ﬂ ILocaI wigmw j
15
ou © | & ¢ & | 7]
Local Files I SizelType
E 3 site - Pizza Palac... Folder
3KE HTML Do
4B Cascadin
Falder
b

3. Now let’s add a picture to our images folder. Go on the Web and do an image search for
“pizza”.
or

Check with your teacher to see if these images have already been saved for you on the
computer.

15



When you find your image, give it the name pizza. Make sure you FILES =
save it to your images folder inside your pizza folder (the folder you [©reardne 2] Jrocven 2]

just created). 5 @ | oo | =
Local Files I Sizel Typ

. L. . . EIC  Sike - Pizza Palace (C:... Foolds

Your Files Panel should now look similar to the graphic to the right. -6 images Eolds

..... @ pizza.jpg 6kE JPEC
indez . ikl 3KE HTMI
L[ twoColFixLtHdr . css 4KB Casc

There are several different ways to add images to your page. The
easiest way is to drag the picture from your Files Panel and drop it
on your page. (You can also click on Insert = Image and navigate to

your picture.)

< | v

7. Place your cursor beside 12” pizza and 9” garlic fingers...Click on your picture name and drag
it onto your page.

I ik
Welcome! 5 cnaiunk
L . & Mamed Anchor
Ciwver 10 years of delicious pizza and pasta, courteous
service, and much more! Horizankal Rule
'E‘ Table
T
Today's Featured Items: Insert D Tag
" pizza and 9" Garlic Fingers - $15.99 5. - Images : Navigation Bar L
@ - Media
12 Buffa BRings - $5.99 bate
2 Super Donairs & ™arge caesar salad - $16.99 ) Serverside Includs o
css srvies RSN
Fries [asSERS I
Ih Pizza Palace j ILocaI WiEw j
. . i v |
Click and drag your picture G | &
Local Files | SizelT!E
fmm y0 ur Files paml to yo ur page = ED Site - Pizza Palace {C:... Folde
E@ images Folde
[~ & pizeajpg 6KE JPEC
T indexc.himl 3KB HTMI
[ - -_;_‘a bwoColFixLEHdr css KB Casc
inConkent> <p [ %] O [100% +|[E39 % 469+ [k 1 sec [Unicode (UTF-8)
#main...j Font | verdana, Arial, Helvetica, sans-serif j ﬂﬂ% = (=(E @
55 Panel Size | 100 v”% v[ﬂ #000000 &

Image Tag Accessibility Attributes

8. When you drop your picture, the Image Tag

Accessibility Attributes window will open. ternate text: @ [ =
Beside Alternate text, write pizza as shown P & Cancel |
here. o |

If ywou don't want to enter this information when inserting
objects, change the Accessibility preferences.

9. Leave the Long description blank and click
OK.

NOTE: A/t tags make your site more accessible to visually impaired

individuals and to non-visual browsers (Some people surf with images
turned off).
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HINT - How to Properly Resize Your Images

The best way to resize your image is to use the “Edit Image Settings” tool shown below. The
pizza picture that we are starting with is too large. The display size of the photo is 1200
pixels wide and 800 pixels in height. The file size of the image is 192K. We want to shrink
the both the display size and the file size. If we reduce the file size too, the picture will

load faster when someone comes to our page.

<bpd¥™> |<imq>|

YPROPERTIES
m Image, 192K w1200
— p H 800

¥ Spatg

|_¥_| O OYX  Hspace

Edit Image
Settings Tool

If you reduce the Scale % of the image from 100% down to 25% as shown below, the display
size of the image goes from 1200 pixels x 800 pixels down to 300 pixels x 200 pixels. The file
size is reduced from 192K down to 23K. You have obtained your goal of reducing both display

size and file size.

— e B "

Image Preview

Elbrevion o -
= o ) Options | File

12 oels
==} R Scale
-]

W: | 1200 pree

%: | 100 - 2 ’
2 L -\4' . -~ -

Image Preview
H: | 800 pixels

. i File
Constrain / Options

Scale

% | 25| 3

W: | 300 pixels ]

H: | 200 pixels

Constrain

Please Note: Using the “Edit Image Settings” tool will alter the properties of your original
image. It is good practice to make a copy of all of your original images before they are

edited.
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HINT - The Click and Drag Method is NOT as Good

If you resize the image by clicking on the corner of the picture and dragging to reduce the size of
the image, it only resizes the display. The actual file size of the file is not altered. This is
important in web design because the smaller the file size of your image, the faster your page will
load. This is particularly important if you have a number of images on a single page.

In the example below, the original display size of the pizza image is 1200 pixels wide by 800 pixels
high, and the file size is 192K. The file size stays at 192K even when you use the click and drag
method to reduce the display size to 300 pixels x 200 pixels. Your page will not load as fast if the
image file size stays at 192K, compared to the same image that was reduced to 23K with the “Edit
Image Setting” method described earlier.

The more images you have on your web page, the more important it is to have each of the images
resized so that your page will load quickly when visitors go to your site.

<body > |<ima>|

Image, 192K w | 1200

(o} H 800

|E| oot H Space |

NOTE: Images can be resized or edited in other graphic editor such as Photoshop,
Paint Shop Pro, or FireWorks. However, Dreamweaver does include a few options

for editing images. Always save an original copy of your image.
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10. Your file should look something similar to the graphic below. Press F12 to preview it in your
web browser. Save the file when prompted. Switch back to Dreamweaver after you have

viewed your site.

index html*

Source Code A ey e ety

§ .| code ‘j split | = Designl | Live View |vl

| LveCode | Titler |Pizza Palace If. G RSN =t

Sidebarl Content

this div will only show
for the length of the
content. If you'd like a
dividing line instead,
place a border on the
left side of the
#mainContent div If it
will always contain
more content,

Daonec eu mi sed turpls
turpis arcu,

pellentesque eget,
cursus et, fermentum

molestie id, varius et,

The background color on

feugiat feuglat, Integer

ut, sapien. Fusce metus
mi, eleifend sollicitudin,

Welcomel

Over 10 years of delicious plzza and pasta, courteous
service, and much morel

Today's Featured Items:

[ o pizza and 9" Garlic Fingers - $15.99
12 Buffalo Wings - $8.99

2 Super Donairs & 1 large caesar salad - $16.99

11. You cannot move pictures around on a web page as easily as you can in a word processor, but
you can use the Properties Panel to adjust some properties of a picture.

12. Click on your picture once to select it. The Properties Panel should display your picture
properties at the bottom of your screen. (NOTE: If the Properties Panel is not showing, click
on Window - Properties. If the full panel is not showing, expand it by clicking on the small
triangle in the bottom right corner of the panel.)

PROPEETIES
Image, &k w121 Stc | images/pizza.jpg L i L Iﬁ Class Im
ID H| 120 Lirk. 95 Edt Ew g 0
Map f Space Targetl j Border _Er i _\
[I] | O F\Cﬁ H Space Criginal G2 | Align lm

13. With your picture still selected, line up your picture and text by changing the Align setting
from “Default” to “Left”. (NOTE: Try the other options as well so you can see what

alignment options are available.)

content. If you'd like a
dividing line instead,
place a border on the
left side of the
#mainContent div if it
will always contain
more content.

Donec eu mi sed turpis

feugiat feugiat. Integer

turpis arcu, :
=l

Today's Featured Items:

12" pizza and 9" Garlic Fingers - $15.99

12 Buffalo Wings - $58.99

2 Super Donairs & 1 large caesar salad -
$16.99

-

| o

<body bwoCalFixLtHdr > <div#container > <div#mainContents <p|<ing:

[ %67 S [100% v 748324~ [12K 2 sec [Unicode (UTF-8)

PROPERTIES

Image, 6K w121 Src | images/pizza.jpg G At |pizza =l Class |twoCoIFi..‘j
i} H 120 Lirk. S Edt gy 4P o

Map ' Space Target Iﬁ EBorder - ) __\

[1] 0 O Tﬁ H Space Qriginal (3.
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14. You can also increase the space around pictures by changing the V Space and H Space

settings. In this case, the H Space setting ha
between the picture and the text.

content. If vou'd like a
dividing line instead,
place a border on the
left side of the
#mainContent div if it
will always contain
more content,

Donec ed mi sed turpis
feugiat feugiat. Integer

Foarmie Siee

1]

Today's Featured Items:

s been changed to 10. Now there is space

]

12" pizza and 9" Garlic Fingers - $15.9¢
12 Buffalo Wings - $8.99

2 Super Donairs & 1 large caesar salad

$16.99
=

<hody.bwoColFixLtHdr > <divi#container > <div#mainContent> <p>[<img=]

[ % ]&% C [100% +|[748 %395+ [12K [ 2 sec [Unicode (UTF-6)

PROPERTIES

Image, &k

W12l Src | images/pizza.jpa

i} H 120 Link:

Map

(x| DO

' Space: Target I
HSpace 10 COriggiilal

15.
16.

Save your file.

e A [pea =] s [twocoRi.. | @
€[> Edt fu 2
7|  Border = E € A

gy Aan e =] N

and give you a preview of what your page will look like when it’s actually on the Web.

17. Switch back to Dreamweaver after you have

18.

viewed your site.

Click on your image to select it. The Properties Panel will change to show other image

editing tools that are available in Dreamweaver. If they are not showing, expand the panel
by clicking on the triangle in the bottom right corner.

Press F12 on your keyboard. This will open your default Web browser (ex. Internet Explorer)

PROPERTIES

Image, 6K w121 Sre | imagespizza. jpg

Yo
Link i Y

Target I 'l

i) H 120 Edit

V' Space Barder

Map

(x| DO

HSpace 10 Original

Al I pizza hd

P
CH € 2 ) “Crop, |
G0 Mign [Left  ——

Class | twoColFi.., ¥

5@

Image Editing Tools:
Crop, Resample, Brighten, Sharpen

19. You can crop, add borders, change the brightness

and contrast, and sharpen images, but you

remember that when you make changes, they get

saved over your original image as shown in t
message below. Always make sure you keep
your original image in case you need it.

Dreamweaver

- The action you are about ko perform will permanently

\E) alter the selected image. You can undo any changes
vou make by selecting Edit = Undo,

need to

he
a copy of

™ Dor't show me this message again,
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20. TO DO: Search for another image and use it as a logo beside the title “Your Name’s Pizza
Palace”. Take some time to practice inserting another image and using the editing features
to alter the appearance of your image. When finished, your site should look similar to the
following:

Pizza Palace

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Sidebarl Content | Welcome!

The background color on Dver 10 years of delicious pizza and pasta, courteous
this div will only show service, and much maore!

for the length of the :

contert, If you'd like & i 1 .

dividing line inctead, | Today's Featured Items:

place a border on the
left side of the
#rmainContent div if it
will always contain
more content,

12" pizza and 9" Garlic Fingers - $15.99
& 12 Buffalo Wings - $8.99

L | 2 Super Donairs & 1 large caesar salad -
= £16.90

Donec eu mi sed turpis
feugiat feugiat, Integer
turpis arcu, :
pellentesque eget,

cursus et, fermentum !
ut, sapien, Fusce metus |
mi. eleifend sollicitudin,

21. Look at the Insert Panel to see what other types of objects can be inserted besides images.
The graphics below show just a few: rollovers, Flash files, navigation bars...

INSERT = H
<ommon ¥ EEiTER <

W Hyperlink, 1= Hyparink N

= Emalik Email Lirk.

.& Mamed Anchor

Mamed Anchar

&= Horizontal Rule :

Al Table 3 Horizontal Rule

Insert Div Tag Table

2 - Images | Insert Div Tag

@ - Media lz‘ - Images ] i

b B [2] Image

= FlashPaper de LI §_1 Image Placeholder

Rollover Image

Fireworks HTHL hd|
1 H& Mavigation Bar

@ Applet

Eg param

83 totiver b Drrave Oval Hotspot
- . 12 Draw Polygon Hotspot

T:I Diraw Rectangle Hotzpot

_5:% PFlugin

22. Rollovers allow you to insert two images. The first image will be displayed if the cursor
outside the image area. As soon as the cursor is moved into the image area, the first image
“rolls over” to display the second image. In the Insert Panel, click on the down arrow
beside images and select Rollover Image.
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23. Select your two images as shown below, and click OK.

Insert Rollover Image @

Image name: lpizza_slice ‘
Original image: | pizza_slice.jpg | (Browsere. )

Rollover image: l pizza_bite.jpg l | Browse. .. |
Preload rollover image

Cancel

Help

Alternate text: [pizza slice - someone taking a bite ]

When clicked, Go to URL: [ J | Browse... I

24. Press F12 to preview your rollover image. Save when prompted.

25. When your page opens in the browser, move your cursor over the image area and you will see
it switch from your first image to your second image.

?) Pizza Slice Rollover - Mozilla Firefox

File Edt View History Bookmarks Tools Help
i c A & [j file:}}/C: {Documents and Settings/jpmutchjDesktop,

(8] Most visited | ] Getting Started |\ Latest Headiines | | Customize Links | | Free Hotma
| '] Pizza Slice Rollover l +

?) Pizza Slice Rollover - Mozilla Firefox
File Edit View History Bookmarks Tools Help

Y, c s‘\ (o) \j file:{{{C: {Documents and Settings/jpmutch/Deskto

(] Most visited | | Getting Started 3\ | Latest Headlines | | Customize Links | | Free Hotw

| ] Pizza Slice Rollover

L]
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Lesson 5: Adding Links

No website is complete without links to other pages. These pages could be within your own site
or links to external pages that are not part of your website. Before you create navigation links,
you need to decide on what other pages you want to have in your site. In our case, we’re going
to keep it simple and create 3 other pages...a menu page, a contact page, and a contest page.
Our file names for these pages will be: menu.html, contact.html, and contest.html.

The links are going to be plain text, but Dreamweaver does have the option of inserting a
navigation bar with buttons. Feel free to explore this option when you create your own site.

1. Highlight all text in the Sidebar1 Content container and press delete.

Pizza Palace

Welcomel!

Cwver 10 years of deli

2. Type the words Pizza Palace Menu, Contact Us, and Contests as shown below.

Pizza Palace

______________________________________

Pizza Palace Menu Welcom'

Contact Us Over 10 years of ¢

service, and much
Contests

3. Highlight Pizza Palace Menu and click on Insert-> Hyperlink (You can also go to the Insert
Panel and select Hyperlink).

4. The Hyperlink dialog box will appear. Type in the link menu.html. (NOTE: If the pages were
already created or the pages stored in a different folder, you should click on the browse

icon.)
Hyperlink gl
Text; | Pizza Palace Menu
<k B>
Title:
Access key:

Tab index:
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5. Click OK. There should now be a link on the menu.

6. Now create a link on Contact Us by highlighting

the words and going to Insert > Hyperlink.

7. The link should be contact.html Text: | Contact Us

Link: | contact. html v | D

oL s

Repeat the process again for Contests. The link should be contests.html

9. Your page should look similar to the following:

Pizza Palace

______________________________________

Fizza Palace Menu WEICOIT

Contact Us Over 10 years o
' service, and mu

Contests

NOTE: If you wanted to link to an external website (ex. Google),
instead of putting in a file name, you would include the entire URL
(ex. http://www.google.ca).

Always avoid using links that say “click here” - they are not descriptive
enough.

10. Save your file.

11. You can preview your file by pressing F12, but remember your links won’t work yet because
we haven’t created those pages.
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Lesson 6: Formatting Text with Cascading Style Sheets

So far, you have learned how to set up a site, create a page from a premade layout, change
content, and add pictures to your site, but we haven’t made any changes to the look of our text.
Changing the size, colour and typeface of your text is not as easy as it is in a word processor. In
a word processor, you can easily change to a different font as long as it is installed on your
computer and if you print your document, the font will print exactly the same as it looks on your
screen.

When you build a web page, if you use a fancy font, the people viewing your site would
need to have the font installed on their computers to display your site properly. To avoid
this, Web designers use a number of “Web safe” fonts that are installed on almost all
computers. They also provide alternates in case the first choice of font is not present. Take a
look at the list below:

Verdana, Arial, Helvetica, Sans-serif

This list means if your visitor's computer has the Verdana font, the browser will use that font to
display the page. Otherwise, the Arial font will be used. If that font is not present, the Helvetica
font will be chosen, and finally, if none of the fonts listed can be found, the browser will use
any Sans-serif font it can find on the computer.

Cascading Stylesheets

Before we go ahead and start changing our fonts, you need to have a bit of an understanding of
the technology that Dreamweaver uses to change the appearance (text and layout) of your page.
This technology is called Cascading Style Sheets or CSS.

An important tip for designing web pages is to be consistent. This means using the same font and
size for all levels of headings, and for all body text on your page. To save time and to ensure
consistency, web designers apply special rules to their web pages. These rules are called
Cascading Style sheets and we create CLASSES to identify different parts of our page (such as
headings or sections on the page).

In the past, if web designers wanted to change all main headings to the same size, font, and
colour, they had to add special font instructions to each heading. Now, with the invention of
CSS, you only have to do this once and it can be applied to all main headings in every page
attached to the style sheet. Think of our Pizza Palace website...let’s say we used Times New
Roman for all of our major headings, but we decided that it looked too plain and we wanted to
change the headings to the font Comic Sans. Without using a style sheet, we would have to
highlight every heading and change the font. With a style sheet, we make the change once
and all headings switch to Comic Sans. Of course, our website is very small, but what if you
had a website with 20 different pages and a heading on each page? This could be very time
consuming!

Alright, let’s practice using CSS.
Turn the page...
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Open Dreamweaver if it’s not already open.

Open your index.html file of your Pizza Palace website.

Let’s begin by changing the font (typeface) of the [Famst] commands site window Hep | @~ &+ &«

main heading “Your Name’s Pizza Palace”. Indent Crtalt+]
Oukdent Chr+-Al+[
Paragraph Format b
Elsl?n : Ia Palace It &4, Ev g
o oefat
i i “« ’ i ” Style ¥ Verdana, Geneva, sans-serif
nghllght Your Name s Plzza Palace * 55 Styles ¥ Georgia, Times New Roman, Times, serif
. . Color... Courier Mew, Courier, monospace
Click Format = Font. A submenu of fonts will arid, Helvatica, sans.sarf
appear. _______________ g Tahoma, Geneva, sans-serif
i Trebuchet 13, Arial, Helvetica, sans-serif
For this website, choose Palatino Linotype, Book Zenu - We Bk, e, et
N . N 3 imes Mew Roman, Times, serif
Antiqua, Palatino, serif. ; P el s, el A i, P e, G
1 Over Lucida Sans Unicode, Lucida Grande, sans-serif

When you click on the font list, The New CSS Rule dialog box will appear. If you selected
just your main heading, the box should look the same as the following.

New C55 Rule x|

Selector Type:

Cancel

Choose a conkextual seleckor bype For your CS5 rule. |

Selector Mame:

Choose or enter a name For your selector,

bwoCalFixLtHdr #oontainer #header bl j

This selector name will apply your rule to ;I

all <h1 = elements

that are within any HTML elements with id "header”

that are within any HTML elements with id "conkainer”

that are within any HTML elements with class "owoCalFixLtHdr", _l;l
¥

1

Less Specific [Gre Spesfic |

Rule Definition:

Choose where your rule will be defined.

I(This docurent only) j Help |

...Continued
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8. We want every “main heading” on
each page of our web site to look
exactly the same, so we need to
create a Class called mainheading.
Change the New CSS Rule box to
look like the following graphic.

9. Click the Selector Type drop down
box and choose Class (can apply to
any HTML element). When you do
this, the Selector Name field
should be empty.

10. You need to enter a name in this
box to describe the block of text
we’re working with. In this case,
we’ll describe it as mainheading.

MNew C55 Rule

Selector Type:

Choose a conk
Class (can apply to anw HTML element) -

Selector Mame:

Choose or enter a name for vour selector,

‘ I-mainheading ) j

This selector name will apply wour rule ko ;I
all HTML elements with class "mainheading".

[less SEesific [MGre Spetifit |

Rule Definition:

Choose where your 1

Cancel

Help |

NOTE: DO NOT include spaces or punctuation marks in the class name.

DO choose names that are descriptive of what you are selecting.

11. The description box under the Selector Name will tell you: This selector name will apply
your rule to all HTML elements with the class “mainheading”.

12. In the Rule Definition box, select twoColFixLtHdr.css. This will save the rule for all main
headings to the css file that you created when you defined your site.

13. Click OK. Your “Your Name’s Pizza Palace” heading should now be in Palatino font. If you
open your menu, contact, and contest pages, you should see that the font has changed on

them too.

4| Design | | | Live Yiew |v 58]

Title: |Pizza Palace

Pizza Palace Menu

Pizza Palace

______________

Welcomel!

Contact Us

Contests

Over 10 years of deli
service, and much me
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14. With CSS you can make changes at any time you want and the site will automatically update
these changes. This can be done through the CSS Panel found on the right side of your

screen.
15. Place your cursor in the “Your Name’s Pizza Palace” Css STYLES | APELEMENTS | o=
heading. Double click on CSS STYLES if it is not expanded as T EER
shown here. (NOTE: If this panel is not showing, go to Window iz:‘t“'"_“’ B Frrr——
9 CSS Panel )° Fzﬁ::?‘:ﬂ;y !::F;Iatino Linotype", "Bo. ..
caolor #000
Abour |"_=| I
This panel ShOWS that the Properties For ".mainheading"

caolor W #000
class “malnheadlng” is black \ ;odndt—Family "Palating Linotyps", "Ba. ..
Property
and is in Palatino font.

5= Agy x4 &

16. As you click on different parts of your page, the style for that section will show up in the CSS
Styles panel.

17. Change the color property for “mainheading” by clicking on  abgut "colos" &I
the color picker. Here the color has been changed to
maroon. As soon as you choose a new color, the Your
Name’s Pizza Palace heading will be updated on all of your
pages. Check it out.

Properties For ".mainheading”

LI I I B I g

18. There are several different properties that can be changed
for each class.

19. To see what other properties can be changed, click on Add Property.

C55 STYLES | AFELEFENES =
all Current |

Summary for Selection

font 100% Verdana, &rial, H...

text-align left

Font-Family "Palatino Linotype", "Bo. ..

calor #9300

About "color" |ﬁ| I

Properties for ".mainheading" C5% STYLES | AP ELEMENTS -=

colar B #900

"Palating Linatype", "Bo... Al Current |

Add Propert Summary for Selection
Fonk 100%: Merdana, Arial, H...
text-align left
fFont-Family "Palating Linoktype", "Bo...
color #2900
font-style italic

20. From the dropdown menu, select Font-Style. About "color” M)
Properties for ".mainheading"
colar W #9000
173 igo Linokype", "Bo...
: onk-skyle italic
&
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21. Choose Italic from the list. The Your Name’s Pizza Palace title on each page should now be a
different color and italic. Check each page of your site to see that the change has

22

23

2
25
26

N
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28

29
30

31

“cascaded” through.

Pizza Palace Menu

Pizza Palace

. Welcome!

. Don’t forget to save your file! Preview your page by pressing F12
, . Farmiat | Commands — Site
- Now let’s change the subheading on each Indent Chrb et
page. Open your index.html file if it isn’t Outdent Chrl+lt+]
already Open Paragraph Format 3
. . . slign Y 2aPalace 1. & =
. Highlight the heading Welcome! List *
. o ot
. C“Ck on Format 9 Font Skyle 3 ‘Verdana, Geneva, sans-serif
. . 53 Shyles 3 Georgia, Times Mew Roman, Times, serif
. SeleCt ComlC SanS MS, cursive Color... Courier Mew, Courier, monospace
— Arial, Helvetica, sans-serif

. The New CSS Rule dialog box will

appear.

. Under the Selector Name, enter the

name subheading.
. Click OK

. The word Welcome! Should now be

in comic sans font

. Use your CSS Styles panel to change
the color of this subheading. (Click
inside the word Welcome so the
properties will show up in the CSS

panel)

Tahoma, Geneva, sans-serif
Trebuchet M3, Arial, Helvetica, sans-serif

[=Tall i w‘ Arial Black, Gadget, sans-serif

Times MNew Roman, Times, serif

Palatino Linokype, Book Antiqua, Palating, serif
O\Felj Lucida Sans Unicode, Lucida Grande, sans-serif
SEMVIC  ms Serif, New vork, serif

Lucida Console, Monaco, monospace

T o d Comic 5ans MS, cursive

New CSS Rule X

Selector Type:
Choose a contextual selector bype For wour C55 rule,

Class {can apply to any HTML element) v
Selector Name:

Choose or entargname for your selectar,
subheading| v

This selector name will apply yvour rule to
all HTML elements with class "subheading".

Rule Definition:

Choose where vour rule will be defined.

broColFixLiHdr . css »

29



32. If your changes do not show up on your other pages, make sure the rule has been applied to
that section of your text. To check, you can view the rule in the Properties Panel at the
bottom of your screen.

33. In the graphic below, the word Menu is highlighted and in the Properties Panel, it’s showing
that no Targeted Rule has been selected. To change this to the subheading formatting, click
on the class subheading from the dropdown menu.

Pizza Palace

Pizza Palace Menu : m

Contact Us ; Pizza:
Contests L 6 -8.00
i 12" -14.99
Home I 15'-18.99
a ]
shody bwoColFixLtHdr = <diva#container = <div#mainContent = (<hl=| E]Q'"D G [100% v | 7S
PROPERTIES
£ HTML Targeted Rule | <Mew £S5 Rulex v| Font | Yerdana, Arial, Helvetica, sans-serif +
=3 Edi Cascade fize 100 v |l% | J[#000
body
bwoColFixLtHdr #container
b alFixLtHdr #mainContent
New Rule

ZMew C55 Rule>
<Mew Inline Style=
Apply Class
<Remove Class>
clearfloat

FltIfE

Fltrt

mainheading

¢ Aoshapes ™ 8 [ fhyocolic thor L-A-=E=5Ra.

You do not always have to use styles. For example, you may want to make one word bold or
italics. This can be done through the Properties Panel. Highlight the desired word and make
sure the HTML option is selected. Here you can choose the formatting options to apply just to
the highlighted word.

PROPERTIES
[<pHTML|  Format Mone v|  dass | twoColFixttHar B|r]| i
o5 1D | Mone ~ Link. \_ __jl % | Target

Page Properties. .,
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Lesson 7: Adding More Pages

In the previous lessons, we added text, graphics, and links to create our homepage. In this
lesson, we’ll add the other pages to our site.

Consistency is very important when creating a website. Your navigation links should be in the
same location on each page, and your colours, fonts, and sizes should be the same. Web
designers use “templates” to make their pages consistent. Once a basic layout has been created
for a site, Dreamweaver has the option to save that page as a template so you can use it over
and over again without having to recreate parts of your page.

Using templates is slightly advanced for this exercise, and since we’re creating a fairly small
site, we’re going to make things a little easier by simply saving your index.html file with
different names and then replacing the content on each page. Remember...if you go on to
continue designing websites, you will want to learn how to use templates.

1. Open your index.html file if it is not already open.
2. Go to File - Save As

3. In the Save As dialog box, make sure you are in the correct folder (in this case “pizza”), and
change the file name to menu.html

Save As E‘El
Save in: |_inzza‘__ v| €] ? ® [T
h N
LY @imagas
uﬁ Eindex.html
" twoColFixLtHdr,
B“U’EEEZZT; rwoCoFiHd.css Make sure you are
= in the correct folder
€
Desktop
My Dacuments
tdy Computer

e e~
._‘] File name:; |menu.hlml ) hd | [ Save ]
- 7 i
My Nebwork, Save as lype: rits [ htm;™ hirnl.* shtm.* shtml:* hta; | [ Cancel ]

Unicode Mormalization Farm:
[Jinclude Unicade Signature (BOM)
4. Click Save
5. Click on File > Save As again, and this time change the file name to contact.html.
6. Click Save E"‘ Fle Edit ‘Wiew Insert Modify Format  Commands
7.

Click on File = Save As one
more time and change the file
name to contests.html. Click
Save

conkests, hkml X _
brwoColFixLtHdr . css*

=] Designl _F | Live View |‘r [<3]

Source Code

<= Split

2| Code

8. If you’ve done this properly,
you should see the names of
the files you just created at the
top of your screen. You can
click on these names to move :
between files. If you have multiple files open, always make sure you’re on the correct page!
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N . | -=
9. Your Files Panel should now show your new files. Frs RS =
[ﬁn Pizza Palace W | |Local wiew W
$o G | b 4 ¥ | =l
10. If your new files are not showing, click once on your site Local Files [ size[Typ
folder to select it and then refresh it by pressing F5. =10 Site - Pizza Palace (C:... ol
EED images Folde
& pizza.jpg &kE JPEC
........ & pizzaz.jpg 3KB JPEC
-T2 conkact,html 3KEB HTMI
11. Let’s change the content for each of these pages. ~T0) contasts.hml 3B HITM)
T indes. bl KB HTMI
-T2 menu,html KB HTMI
_:_L- b olFixLiHdr  cs5 4KE Casc
£ >

12. Click on the contact.html page and change the content as
follows. Feel free to make up your own information

RIS contact.hem > | esieasES N S S e

IFixLtHdr . css*

|5 Design | | # | Live Miew |v <5 Title: | Pizza Palace It &), EY

Pizza Palace

Pizza Palace Menu COI‘ItaCt

Contact Us Restaurant Location:

Contests 555 Pizza Lane
: Anywhere PE C14 2V7

Take Out Orders: (902 555-5555]

13. Save your file.

14. Open contests.html and change the content as follows. Remember to save your file.

Pizza Palace

Pizza Palace Menu ContestS

Contact Us Every month one lucky customer wins!

Contests You could enjoy a large round 15" Pizza every month for a
: year! Make sure vou fill out a ballot on your next visit to
Pizza Palace or email yvour name and phone number to;

contest@pizzapalace.com

15. To add the email link, go to Insert - Email link and type the address
contest@ pizzapalace.com in the Email link dialog box.
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16. Open menu.html and change the content. Use the menu below or make up your own.

17.

18.

19.
20.
21.

22.

23.

24,
25.

Remember to save your file when finished.

Pizza Palace

_____________________________________

Pizza Palace Menu Men u
Contact Us Pizza:
Contests 5" - 8,09
: 12" - 14.99
15" -18.99
Toppings: |

Mushrooms, Onions, Fineapple, Olives, Green Peppers,
Tomatoes, Pepperoni, Salami, Crumbled Bacon, Italian

Sausage, Ground Beef
Pasta:
lasagna - 10,99

spaghetti - 9.99
seafood pasta - 13.99

One item we need to add to each page is a Home link to get
back to our main page.

On the menu page, type the word Home under your contests
link.

Highlight Home
Go to Insert > Hyperlink
in the Link box, type index.html

Click OK

Text: | Home

Link: | indes.htrml] v D

Targek: b

Pizza Pal:

Pizza Palace Menu Mel
Contact Us Pizza:

Contests g'-89

: 12" -1«

15" - 1¢

Tt o

Highlight the Home link and copy and paste it to the contact and contest pages.

Save each file

Press F12 to preview your site. Do your links work?

Congratulations! You’ve just built a basic web site!!

But now, let’s add some colour!!
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Lesson 8: Formatting Background Colours

In the previous lesson, you were given an introduction to using cascading stylesheets to change
the colour and style of your text. In this lesson, you will change the background colours of your
site.

1. Open your index.html file if it is not already open.

2. Click on the edge of the box surrounding your header.

5] Design] || Live View |v 5] Title: | Pizza Palace If. &, E_ . B checkPage

i

~za Palace Click on the border of the

header to select it. \

3. Since we used a premade layout, there are some style rules | ©5¢ STYLES [ARELEMENTS E

ke

that have already been created. When you select parts of Al | Current |
the layout, their CSS properties will show up in the CSS Summary for Selection
Styles Panel. In the graphic below, it shows the properties E;T:r ot Verdana) fria 4
for the header. If this doesn’t show up, then you do not text-align left
background #DDDDDD
have the correct part of the layout selected. i 0 109 0 20px =
. harkaronnd-ralare
4. The background color here is grey. Abgut ST i
. ies for ".twoColFixLtHdr #header"
Click on the color selector and change the background to a  [Segr® ™ P P
pale yellow color. Make sure you have the correct element | backgraund-caler [J #CCC
indi [peements [ o] | paddng 0 10p> 0 20px
sglected as indicated on the TnlE dd Propett
right. If you make a mistake, Al |current |
Ctrl-Z will undo the last S S T Te _
change you made o prei —
text-align left &= aﬂ'l*i” = 4
backgraund #0DODDD
padding 0 10px 0 20px 3
harkaro nd-ralae Elnas
#About "background-color" |ﬁ] It
Properties for ".twoColFixLtHdr #header"

background #DDODDD
-color CC

6. Your index.html file should look similar to the following. Open one of your other files. You
should see that the change has been made there as well.
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7. Click on the border of the box that contains your links
to select it. Notice the codes at the top of your
Properties Panel. These are the html codes showing

Pizza Pa

what is selected.

Cc
8. In the CSS Styles Panel, change the color of the Res

background to another color.
555
Ay

CSS STYLES [JABIELEMENTSH| -=

All Current | Take

Summary for Selection Note the codes at the Hottom

IEFXtt'a"g” :EFE s of your window. These shbw what
[afs] <]

width 200px portion of your page is sklected.
background #EEEEEE Knowing HTML will help yogjunderstan
padding 15px 10px 15px 20px this a little mor:
hackarnnnd-ralae E i v

Abour "background-color” |i| [®

Properties for ".tvoColFixLtHdr #sidebar1" :/

background #EBEBEE i

background-color ] #CCC Adr= <divdcontainer = [<divisidebar1 =]

Float left

padding 15px 10px 15px 20px

width 200p

Add Property

2= Agd[td] & ¥ &

9. Once you change the background color, your navigation bar should be the same color on each
of your pages. Check your other pages. Did it work?

10. Make sure your colors are complimentary and your text is easy to read.

11. Your Pizza Palace website should be pretty much complete. Feel free to play with the site
more if you need more practice. One more item you might want to try is to create a style for
your links - change their color and remove the line below the words.

Working with Cascading Style Sheets takes a lot of practice. There are many more
features of CSS that were not included in this exercise (including how to position
elements on your page). As you become more familiar with Dreamweaver or web
page design in general, you may decide you want to learn more about CSS. At the
end of this module, you will find a list of websites that will help you gain a better
understanding of HTML and CSS.

The previous lessons gave you an overview of the capabilities of Dreamweaver.
Feel free to explore this software more or “get your hands dirty” with some
coding!

There are millions and millions of websites out there. Having the skills to create
one is a powerful thing!
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Part II: Web Design Considerations

Lots of people know how to create a website, but how many people know how to create a GOOD
website? In the following three exercises, you are going to examine the different items that you
need to consider prior to building a website.

Exercise 1: Web Design Tips

We’ve all seen poorly designed websites that make us immediately switch to another site. What
is it about a site that makes it good or bad? Does the page take a long time to load? Are the
colours too hard on the eyes? Is the text too hard to read? These are just a few items that
designers have to consider when building a site.

Whether you are creating a simple website for yourself or you’re designing a site for a powerful
company, there are certain items that you need to keep in mind. For example, don’t overcrowd
your page, keep your image sizes small, and divide your page into readable chunks (not long
paragraphs) are just a few items to consider when building a site.

TO DO:
1. Complete a search for web page design tips.

2. From the tips that you find, create a list of at least 10 items that you need to keep in mind
when designing a website. Record your list in a Word or WordPerfect file.

3. Share your list with a partner to see if there are items that you did not consider.

Exercise 2: Web Accessibility

What does Web accessibility mean? Can all people access all parts of your website? Are there
special things you can do to ensure that the majority of people will be able to view/hear/read
everything that you include on your site?

TO DO:
1. Complete a search for Web Accessibility.
2. Explain what Web accessibility is and why it is important.

3. Create a list of at least 5 things you can do to make sure your site is accessible. Record your
list in a WordPerfect file.

4. Share your list with a partner to see if there are items that you did not consider.

Locate a site that you could use to check the accessibility of your website.
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Exercise 3: Evaluating a Website

In the previous two exercises, you examined both design and accessibility issues that arise when
building a website. In this exercise you are going to use the knowledge you just gained to
evaluate a website. When searching the Web, some websites often stand out more than others.
What makes us spend more time on one site and flip through another quickly? What makes a
“good” website? The following elements all need to be considered when evaluating a site.

¢ Navigation - the text links, icons, buttons, bars and other objects used for exploring the

page and any linked pages

e Content - all the information contained within the page (text, graphics, and other media

elements embedded in the page)

e Design - organization of the elements in the page; the general look or feel of the page
(aesthetic value)

e Accessibility - making websites usable by people of all abilities and disabilities
e Technical Considerations

e Accuracy/Reliability

TO DO:

Choose a website with which you are familiar (and which is accessible at school) and answer
each of the following questions in a new WordPerfect document. When finished, write a short
paragraph identifying what you believe is done well and what could be done to improve the site.

9.

Is the content obviously separated from the navigational menu?

Are links labeled with identifiable text (instead of “click here”)?

Is there a consistent theme throughout the site and is all content related to that theme?
Is there consistency throughout the site (headings, colours, navigation)?

Is the text easy to read?

Are the colours complimentary?

Are there Alt tags on all images and text-based alternatives to explain essential information
in images and media elements?

Are all images and links functional?

Does the page take a long time to load?

10. Did the creator provide a “date last updated” and contact information?
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Part III - Final Project - Creating an Original Website

Now you know how to build a basic site, and you know what design and accessibility items you
need to keep in mind. Your final assignment is to create an original website on a topic of your
choice (approved by your teacher). You must provide a plan of your website prior to building it
in a web editor like Dreamweaver. This involves creating a storyboard for your site (use
Inspiration if you wish).

A storyboard is a visual plan for your website. It usually consists of a series of pages that
include a rough sketch outlining the content, navigation, and design elements of your website.
Storyboarding saves time and results in a high quality website. Before you create the storyboard,
collect the information you want to put on the website and organize the information into topics.
Follow the steps below to help you get organized.

1. Collect the information that you want to include on the website. This includes text as well as
images.

2. Sort the information into topics. Topics should start at the broadest and work toward the
narrowest.

3. For each page of the website, determine page title, headings, sub headings and content.

4. Choose a colour palette for your site. Background colours, headings, sub headings, borders,
content, etc. should be complimentary. Try using a site such as
http://www.colorcombos.com/ to find the most suitable combinations. You’ll need to know
the hex codes to set up your styles for each part of your page.

5. On your storyboard, plan the structure of the information and how the pages will link (the

navigation). You should be able to get to any part of your site from any part of your site.

Choose a layout for your pages. (This is the page that will be used to build all other pages)

Layout the navigational structure (Navigational links should be in the same location on each

page).

8. Test the layout. Imagine that you are a visitor to the website. Can you enter at any page and
find your way easily throughout the site?

Neo

A sample of a blank storyboard is included following this page.

Your site must be a balance of text and images (It can’t be all pictures!) and must:

have a minimum of 3 pages (one of which is your homepage)

use Dreamweaver layouts

have consistent colours and fonts on each page

have consistent navigation (each page must have links to each of the other pages,

located in the same position on each page. Don’t create a link to the page you are

already on.)

¢ have consistent sizes for different elements (main headings, subheadings, body
paragraphs etc)

e have a minimum of 2 external links (links to pages related to your site)

e include at least 4 images

e have relevant text

Once you’re ready to start working in Dreamweaver...
the first step is to DEFINE A SITE.

Check the next page for a reminder of how to do this.



http://www.colorcombos.com/

1. Open Dreamweaver
2. Click on Site > New Site

dify  Format  Commal Site | wirn Help | B~ &~ &~

[t [l Ehtes
[Eteck [t [t S it

[t [l Ehtesl
w Eteck [ [t S it

The Site Definition window will open.

Name your site. Give your site a hame according to your topic.
Don’t worry about the URL of your site.

Click Next

When asked if you want to work with
server technology, make sure “No” is =
selected. Site Definition 5
8. Click Next

N O o1 NW

Biasic | Advanced I

Editing Files, Part 2 Testing Files Sharing Files

Do wiou wank bo work with a server technology such as ColdFusion, ASP.I

& o, Idono
€ Yes, I want b use a server technology.

ank to use a server kechnology,

9. Make sure you have “Edit local copies
on my machine...” selected.

Editing Files, Part 3 Testing Files Sharing Files

How do wou want to work with vour files during development?

() Edit Io%al capies on my machine, then upload ko server when ready (recommended)
10. Identify where your website files will I s A B S
be stored. Type
G:\webpage_design\foldername

(unleSS tOld tO do OtherWise by y.our Where on your computer do you wanteestare your files?
teaCher). Replace fOldername W]th the & \webpage_designifoldername| o
name of the folder where you will be

storing your site.

(NOTE: Every website should have its own folder. The G: drive was selected here because
that is where you must save all your files while at school. If you were working at home, you
would choose another location).

11. Click Next
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12.

13.

14.

15.

16.

In the next window, click on the :
dropdown arrow and select None Basic | advanced |
when asked how you connect to

your remote server. Site Definition

Editing Files Testing Files Sharing Files
Click Next
In the Site Definition Summary window, click Done.

Your site folder should now be showing in the Files Panel at the bottom right of your
screen. (If the Files Panel is not showing, press F8)

You’re ready to add your homepage to your site by clicking on File > New and selecting
a layout.
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This is just a sample storyboard. There are many different designs that could be used. As long as
you have the relevant information and a sketch of your pages, the appearance of the storyboard
is not important. For this storyboard, you must complete one sheet for each page in your site.

Sample Website Storyboard

Storyboard Template
Your Name: Topic:
Descriptive title of page: File name:

Description of text to be
included on page:

Links on the page:

Navigation:

Graphical Elements/Images:

Colours:

Font specs: (size, face, style)

Provide a thumbnail sketch of the page layout below.

41




Assessment Rubric:

4 3 2 1

layout The Website has an The Web pages have | The Web pages have | The Web pages are
exceptionally an attractive and a usable layout, but cluttered looking or
attractive and usable | usable layout. It is may appear busy or confusing. It is often
layout. It is easy to easy to locate all boring. It is easy to difficult to locate
locate all important important elements. | locate most of the important elements.
elements. White important elements.
space, graphic
elements and/or
alignment are used
effectively to
organize material.

Content The site has a well- The site has a clearly | The purpose and The site lacks a

stated clear purpose
and theme that is
carried out
throughout the site.

stated purpose and
theme, but may have
one or two elements
that do not seem to
be related to it.

theme of the site is
somewhat muddy or
vague.

purpose and theme.

Links (Content)

All links point to
high quality, up-to-
date, credible sites.

Almost all links point
to high quality, up-
to-date, credible
sites.

Most links point to
high quality, up-to-
date, credible sites.

Less than 3/4 of the
links point to high
quality, up-to-date,
credible sites.

Navigation Links for navigation Links for navigation Links for navigation Some links do not
are clearly labeled, are clearly labeled, take the reader take the reader to
consistently placed, allow the reader to where s/he expects the sites described. A
allow the reader to easily move from a to go, but some user typically feels
easily move from a page to related needed links seem to | lost.
page to related pages (forward and be missing. A user
pages (forward and back), and internal sometimes gets lost.
back), and take the links take the reader
reader where s/he where s/he expects
expects to go. A user | togo. A user rarely
does not become becomes lost.
lost.

Functionality All links and images All but one link or 2-3 links or images Links and images are
are visible and image are visible and | are broken. broken throughout
working working the site.

Colour Choices Colors of Colors of Colors of Colors of

background, fonts,
unvisited and visited
links form a pleasing
palette, do not
detract from the
content, and are
consistent across
pages.

background, fonts,
unvisited and visited
links do not detract
from the content,
and are consistent
across pages.

background, fonts,
unvisited and visited
links do not detract
from the content.

background, fonts,
unvisited and visited
links make the
content hard to read
or otherwise distract
the reader.

Total:

/24

*Partially designed using Rubistar
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Useful Websites

http://www.webmonkey.com - great lessons to learn basic HTML and CSS

http://html-color-codes.com/ - colour codes

http://wave.webaim.org/ - checking web accessibility

http://www.webpagesthatsuck.com/ - good tips for design

http://www.avivadirectory.com/color/ - colour resources for designers

http://webdesign.about.com/od/beginningcss/a/bl_csstutorial.htm - Basic Cascading Style
Sheets Tutorial
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